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1 INTRODUCTION 

1.1  What is TRMS?  

Since a number of years enhanced collaboration is one of major trends in industry. 
Collaborative engineering (CE) is a new paradigm for product development which 
integrates widely distributed engineers for virtual collaboration. The major obstacle in 
stronger proliferation of CE practices is the lack of appropriate infrastructures suitable for 
distributed engineering work.  

Tool Registration and Management System (TRMS) is an innovative solution that 
constitutes a kernel of the collaborative infrastructure, as it enables distance-spanning 
tool integration. Once registered, tools provide their services to distributed engineers. 
Advanced service discovery methods are used to connect to the most appropriate service 
with respect to optimal availability within the current configuration of the virtual 
engineering network. TRMS guarantees secure data transfer with authentication and 
authorisation of users, as well as it includes security management mechanisms that allow 
administrator to monitor users' activity and to execute a proper security policy.  TRMS 
allows design teams to make their resources available to the others. It is thus intended for 
distributed engineer groups collaborating on the same project and using shared tools. 
 
TRMS was developed by the EU E-Colleg Project (IST-1999-11746, www.ecolleg.org). 
 

 
 

Figure 1.1: Main window of the TRMS Client application 
 

1.2 TRMS Key Features 

TRMS enables to use tools that have been installed in geographically dispersed 
locations.  Built-in mechanisms make tool integration very easy.  This means 
straightforward tool registration and invocation.  TRMS provides a user with a comfortable 
interface - the TRMS Client for looking for a required tool. It makes user’s work more 
efficient and saves his/her time.  Only tools pre-registred in the system may be searched 
for. Registered tools are configured for integration due to automatically generated XML-
based interfaces. Of course, one needs rights to use a particular tool. Management of 
users and their multilevel privileges is a strong asset of the system. Cryptography 
techniques and digital signature technology protect project data on their way through the 
network, as well as protect access to the system.  
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 Advanced Network Transport Service (ANTS) enable exchange of project data through 
existing firewall systems without a need for their reconfiguration. TRMS has its own 
workflow management system that simplifies management of tasks realised by a 
distributed engineering environment. TRMS uses ecollegML markup language for 
description of: tools, tasks, and workflows. 
 

1.3 TRMS Architecture 

A general architecture of the TRMS in the simplified perspective includes three basic 
components: Global Tool Lookup Server (GTLS), Tool Server (TS) and Client. 
Additionally, Advanced Network Transport Services (ANTS) supporting communication 
and Data Bases Server (DB) responsible for data storage complete the architecture. The 
main component GTLS is responsible for registration and modification of data on users 
and their privileges, elements of the system, as well as, information on accessible tools 
and machines that make them available. GTLS is also responsible for the security policy 
of the whole system. The ANTS is a SOAP web service that enables routed data 
transport through gateways and firewalls. TRMS uses ANTS for the transport of all data 
between clients and remote tools. ANTS can also be used to distribute SOAP messages 
across network boundaries. It enables TRMS to be deployed fully independent of the 
network infrastructure when ANTS connectivity is supported. DB server contains two 
databases: a native XML DB Exists with tool descriptions and the relational DB 
PostgreSQL with information on users and their privileges.  TS is responsible for 
confirmation of users identity and privileges, as well as directly launches the tool. 
 

 
 
 

Figure 1.2   TRMS architecture 
 
 
 
2 INSTALLATION AND CONFIGURATION 

2.1 System requirements 

 
♦ Operating System:  

 TRMS is independent on the operating system platform. It has been tested on the 
following OS: Windows 2000, Windows XP, Linux (Mandrake 10), Solaris 8 

♦ Minimum Hardware Requirements:  
 Processor platform i586, i686 
 Memory RAM minimum 64MB (greater recommended)  
 Installed Disk Space 10 MB or more of free hard drive space  

♦ Minimum Software Requirements: 
 Installed Java 2 Platform, Standard Edition (J2SE)1 
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1NOTE: TRMS  has been tested with J2SE 1.4.0_x, 1.4.1_x, 1.4.2_x and 1.5_x. Unfortunately, we have noticed 
some problems with J2SE 1.4.2_x. It is caused by a lack of compatibility in attendance of JCEKS keystore file in 
this edition (http://developer.java.sun.com/developer/bugParade/bugs/4887561.html). JCE keystore files store 
generated private and public keys for all system components, as well as for each user. The JCE keystore file 
created in other version J2SE then 1.4.2_x is incorrectly read by this edition. We suggest creation of the new 
JCE keystore file and registration of new public and private keys in the GTLS database after each change of 
J2SE edition. 
 
2.2 TRMS installation 

A general architecture of the TRMS in the simplified perspective includes three basic 
components: Global Tool Lookup Server (GTLS), Tool Server (TS) and Client. They are 
delivered in the form of one archive (zip file). Installation requires unpacking of this 
archive to an optional folder and a proper modification of the configuration files.  
 
   Table 2.1: Contents of the installation folder 

Folders and files Contents 

/config Configuration files 

/doc Documentation 

/keys Default localization of the files storing user’s private 
and public keys and the GTLS public key 

/lib/ciel/cielicons.zip File with graphics used by TRMS 

/lib/ciel/trms-ciel.jar Library file with TRMS 

/lib/ciel Libraries used by TRMS 

/lib Additional libraries essential for correct TRMS 
operation (e.g. ANTS) 

/resource Graphics files used by TRMS 

/sampleconfig Exemplary configuration files for ANTS 

/sampletooldesc Exemplary files describing tools 

/scripts Scripts starting up an environment 

/tmp Working directory. Default directory for temporary  
and outcome files   

/antsnames.txt File with hosts’ names and node numbers (used by 
ANTS) 

/trms.jar ANTS Library 

 
 
 

2.3 Configuration files 

The TRMS environment employs a number of configuration files that allows a user to 
match the environment to requirements. All files are defined in the XML format.  
Configuration files are localized in the config subdirectory (an exception is the ANTS 
configuration file which is located in the script subdirectory). The config directory includes 
the following files: GlobalConfig.xml, GTLSConfig.xml, ClientConfig.xml, TSConfig.xml. 

The GlobalConfig.xml file should exist in every TRMS distribution. It contains setups 
common for all TRMS’ components. Remaining files (GTLSConfig.xml, ClientConfig.xml, 
TSConfig.xm) are used by individual parts of the TRMS environment.  
 
The GlobalConfig.xml file includes the following XML tags:   
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Table 2.2:  GlobalConfig.xml file 
TAG         VALUE/ 

 DEFAULT VALUE 
DESCRIPTION 

type_communication_with_gtls tomcat/ants Type of communication with the GTLS 
server. 

level_debug user/administrator/developer It specifies the range of messages displayed 
on the screen. 

encryption yes/no It switches on encryption during 
communication. All components of the 
TRMS environment must have the same 
setups. 

compression_message yes/no It switches on compression of files during 
communication (it is useful with slow 
networks ) 

enable_local_cache yes/no It switches on caching data on a local disk It 
decreases frequency of communication with 
GTLS server and databases. 

time_delay_ping_to_gtls (Integer) 1200  Frequency with that TS or client application 
is communicated with GTLS server for 
confirmations of its availability. 

with_proxy yes/no YES in a proxy server presence.  
proxy_host (IP lub url) The proxy server IP or URL  
proxy_port (Integer) The proxy server port number. 
proxy_user_name (String) User name for the proxy server, if it is 

required. 
proxy_user_password (String) A password for the proxy server, if it is 

required. 
 
 
 
Setups concerning client application are placed in the ClientConfig.xml file. This file 
includes the following XML tags: 
 
Table 2.3:  ClientConfig.xml file 

TAG         VALUE/ 
DEFAULT VALUE

DESCRIPTION 

gui_type simple/ts_manage/full It allows the administrator to hide some 
functions of the client application and match 
GUI with user’s requirements. The mode 
simple (simplified GUI) is useful, if user has 
access to searching out and launching tools 
only. Remaining functions are reserved for an 
administrator. 

ip (URI) 
157.158.96.14:8080 

The GTLS Server’s  IP address and port 
number 

nodeid (ANTS Node)  The ANTS node number (It is used in case 
when ANTS type of communication has been 
chosen). 

gtls_public_key_file C:\TRMS\keys\gtls.cer The certificate with GTLS server’s public key 
localization. 

dir_default_client_pair_secret_key C:\TRMS\keys Localization of the file storing user’s private 
and public keys. 

dir_install C:\TRMS Target directory for client application. 
dir_working C:\TRMS\work Working directory. Default directory for 

temporary  and outcome files   
ants_config  The nodeconfig.xml file localization. The script 

directory is default localization 
localANTS http://localhost:8080 The IP address on which the ANTS server has 

to listen to incoming messages.  
 
 
 
Setups concerning the GTLS Server are placed in the GTLSConfig.xml file. The 
configuration file includes proper parameters for use of databases 
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Table 2.4:  GTLSConfig.xml file 
TAG         VALUE/ 

DEFAULT VALUE
DESCRIPTION 

login  User name for a database. 
password  A password for a database 
url  The database localization. 
driver  The database driver 
gtls_pair_secret_key_file  Localization of the file storing GTLS server’s private and 

public keys. 
dir_install C:\TRMS Target directory for GTLS Server installation. 
dir_working C:\TRMS\work Working directory. Default directory for temporary  and 

outcome files   
ants_config  The nodeconfig.xml file localization. The script directory is 

default localization 
localANTS http://localhost:8080 IP address on which the ANTS server has to listen to 

incoming messages. 
 
 
Setups concerning a Tool Server are placed in the TSConfig.xml file. This file includes 
the following XML tags: 
 
Table 2.5:  TSConfig.xml file 

TAG         VALUE/ 
DEFAULT VALUE

DESCRIPTION 

ts_id (String) Name of a Tool Server.  This name should be registered 
in GTLS database. 

ts_communication_type tomcat/ants Type of communication with the GTLS server. 
ip (URI) 

157.158.96.14:8080 
The GTLS Server’s IP address and a port number. 

nodeid (ANTS Node)  The ANTS node number (It is used in case when ANTS 
type of communication  has been chosen). 

gtls_public_key_file C:\TRMS\keys\gtls.cer The certificate with GTLS server’s public key 
localization. 

ts_pair_secret_key_file C:\TRMS\keys Localization of the file storing Tool Server’s private and 
public keys. 

dir_install C:\TRMS Target directory for Tool Server installation. 
dir_working C:\TRMS\work Working directory. Default directory for temporary  and 

outcome files   
ants_config  The nodeconfig.xml file localization. The script directory 

is default localization 
localANTS http://localhost:8080 The IP address on which the ANTS server has to listen 

to incoming messages. 
 
 
 
3 QUICK TOUR 

3.1 Login 

The Login Menu enables a user to perform three basic operations: login to and logout 
from the TRMS system, as well as safe closing of the client application. 
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Figure 3.1: Login menu 
 
 

3.2 Workflow 

The Workflow Menu includes two items. The first one (Workflow) enables the user to 
create a simple workflow through sequence launch of distributed tools in such a way, that 
exit data of the first tool is input data for the second one. For this purpose a simple 
graphic workflow editor is used. The second item (Tool invoke) is used for invocation of 
remote tools.   
 

 
 

Figure 3.2: Workflow menu 
 
 

3.3 Tool/Task 

Invocation and management of tools, tasks, as well as workflows is possible through the 
Tool/Task Menu. It comprises four items, which enable the user to add new tools and 
effectively manage the registered tools. Depending on user’s own privileges, the user can 
access a whole or a part of the Tool/Task Menu. Basically, a regular user can only 
browse information about registered tools and remotely launch them (if he owns sufficient 
privileges for launching these tools). Instruments for registration of new tools and suitable 
configuration of tools registered are reserved for an administrator. More information on 
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how to add a new tool, modify and delete registered tools one may find in section 
Tool/Task – How to..? 
 
 

 
 

Figure 3.3: Tool/Task menu 
 
3.4 Tool Servers 

The Tool Servers Menu enables efficient management of Tool Servers. Four operations 
are available: adding a new Tool Server, as well as deleting, browsing and modifying 
parameters of registered Tool Servers. Depending on the user’s own privileges a user 
can access a whole, or a part of the Tool Servers Menu. Due to the security reasons, 
most often the user owns privileges for browsing registered Tool Servers only. 
Instruments for registration of new Tool Servers and configuration the registered ones are 
reserved for the administrator. More information on how to add a new Tool Server, modify 
and/or delete the registered one, can be found in section Tool Servers – How to..? 
 
 

 
 

Figure 3.4: Tool Server menu 
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3.5 Users 

Management of users is realised through the Users Menu. It comprises seven items, 
which enable proficient management of new and registered users and their privileges. 
Depending on the user own privileges the user can access a whole or a part of the Users 
Menu. Basically, a regular user can only browse information about other registered users 
and their privileges. Instruments for suitable configuration of users’ accounts and their 
membership in a proper group and an institution are reserved for the administrator. More 
information on how to add a new user, modify and delete the registered ones one can 
find in section Users – How to..? 
 

 
 

Figure 3.5: User menu 
 

3.6 Options 

The Options Menu includes four items. The User configuration item enables suitable 
configuration of the client application through setup of proper parameters determining 
cooperation with the GTLS server and Tool Servers. The User profile item displays 
complete information about the logged user. The Look & Feel item allows the user to 
change an appearance of the client application. The Close all Windows item closes all 
opened windows. 
 

 
 

Figure 3.6: Options menu 
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3.7 Administration 

The Administration Menu allows the user a suitable configuration of the GTLS server 
that is the main component of the TRMS. It enables looking after the users' activity and 
the availability of Tool Servers. The Administration Menu includes the following four 
items:  

 GTLS configuration - for GTLS management (proper privileges are required)   
 TS sessions - shows information on currently active and used Tool Servers 
 User sessions - identifies users currently logged to the system.  
 Log - enables access to logs with information on users and Tool Servers' activity. 

 

 
 

Figure 3.7: Administration menu 
 

3.8 Help 

The Help Menu allows access to two items. The first one (Help) is the simplified version 
of the current manual; the second one (About) includes information about version and 
copyright. 

 

 
 

Figure 3.8: Help menu 
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4 LOGIN TO TRMS 

4.1 How to login to TRMS? 

 
The Login operation to the TRMS system is indispensable. To log in, one has to make 
the following steps: 
 
Open the Login Menu and choose Login item 
 

 
 

Figure 4.1: Login menu 
 

Point at location of the file with one’s own pair of keys. 
 

 
 

Figure 4.2: Choose file window 
 

Enter access password to the file. 
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Figure 4.3: Enter password window 
 

If password and file location are correct corresponding message will appear. 
 

 
 

Figure 4.4: Message box 
 

Enter the correct authentication credentials. 
 

 
 

Figure 4.5: Enter credentials window 
 

Now, you are logged to the system. All bookmarks are available. The right message is 
displayed. 

 
 

Figure 4.6: Main window 
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5 WORKFLOW – HOW TO …? 

5.1 Create a new workflow 

The Workflow Menu allows the user to create a new workflow. Open the Workflow 
menu and select the Workflow item. A new window with a graphic workflow editor will be 
displayed. 
 

 
 

Figure 5.1: Workflow menu 
 
The workflow designer window includes two bookmarks: Designer and Main info. The 
Main info bookmark allows a designer to enter general information of the created 
workflow. 
 

 
 

Figure 5.2: Main info bookmark 
 
The Designer bookmark displayed below includes two blocks start and stop, which 
represent beginning and the end of the designed workflow. Each new block will be 

inserted between them and represents a task. Click on the Add new block  button. 
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Figure 5.3: Designer window 
 

A new block appears in the designer window. 
 

 
 

Figure 5.4: Adding a new block 
 
The user can declare a new task represented by the block in two ways. The task can be 
imported from the earlier prepared XML file or just created ad hoc. 
 
Import the task 

Click on the Import button. A new window appears. The Select file window allows the 
user to select location of a task file. Next, click on the Choose button. 
 

 
Figure 5.5: Choose file window 
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The task has been imported.  
 
Create the task 

If one wants to create/declare a new task, click on the Edit block  button or double 
click on the block. A new window appears. The same window is used for tool invocation. 
The detailed description on filling in all fields is available in section 5.3 Launch a tool. 
 

 
 

Figure 5.6: Edit task window 
 
When the task is imported or created, the user has to update parameters of the 
imported/created task. This process checks correctness of the task configuration. TRMS 
verifies all parameters essential for a successful tool invocation. Click on the Actualize 
button. 
 

 
 

Figure 5.7: Designer window 
 

The user can also modify any time task settings by clicking on the Edit block  button. 
 



 
 
TRMS User’s Manual                            Vers. 2004-11-18 19

 
 

Figure 5.8: Edit task window 
 

If all parameters are correct the task can be run. Click on the Run selected tool   
button. 

 
 

Figure 5.9: Workflow window – run task 
 
The end of the task operation is indicated by a green light at the light controller. If the 
user wants to add more tasks to the workflow he repeats the action of adding a task. 
 

 
 

Figure 5.10: Workflow window – the end of task operation 
 
The created workflow can be saved as an XML file. Click on the Export   
button and select a proper location.  
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5.2 Launch a workflow 

The Workflow Menu enables the user to import and launch prepared workflows. Open 
the Workflow menu and chose the Workflow item. A new window with the graphic 
workflow editor appears. 
 

 
 

Figure 5.11: Workflow item 
 

Click on the Import    button in the workflow editor window. 
 

 
 

Figure 5.12: Workflow designer window 
 
 

Choose a file with the earlier prepared workflow. 
 

 
 

Figure 5.13: Choose file window 
 

The workflow is imported. Now, click on the  button to execute the workflow. 
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Figure 5.14: Imported workflow 
 

5.3 Tool invocation 

 
Tool invocation is realised through the Workflow Menu and selection of the Tool invoke 
item.  

 
 

 
 

Figure 5.15: Tool invoke item 

A new window with details will be displayed on the screen. Now, click on the  
button.  

 

 
 

Figure 5.16: Tool invoke window 
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After activation of this item a proper searching window will be displayed. Tool name and 

keywords can be entered as the attributes of a searched tool. Next, press the  
button. The result of searching will be displayed as a table. If no attributes are given then 
all tools currently registered in the TRMS database will be displayed.  

 

 
 

Figure 5.17: Search window 
 
When the user wants to launch a local tool in the "Invoke editor" he must select the "Local 
tool" then the tool will be invoked on the local machine without using a remote Tool 
Server. He must put the "path", the "working directory" and also the "value of the 
parameter". The fields: the name/description" and the "name of parameter" are optional.  
Note that "the definition of the local tool" one can also export to a XML file (the optional 
fields will be also exported).  

 

 
 

Figure 5.18: Local tool invocation window 
 
 
The table consists of five columns which give the user basic information of the tools 
registered in TRMS. Data in Name and Keyword fields can be used for searching a tool. 
The other fields include info of tools, their location, as well as availability. Mark the 
searched tool and click on the  button. A proper window with details appears.  
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Figure 5.19: Search result 
 
In this example the bmp2jpg tool was chosen. It makes a picture conversion from bmp to 
jpg standard. In a new window the user can see Name of the tool and its Version. TS 
name informs on which Tool Server the tool is installed. Clicking on the Check TS button 
the user can check if this Tool Server is available. 
 

 
Figure 5.20: Tool invocation menu 

 
The Parameters bookmark enables the user to specify parameters required for a correct 
tool invocation. Each parameter added by the user is visible in the command line 
displayed in red. With this command line the tool is remotely launched at the Tool Server 
side.  

 
Figure 5.21: Parameter bookmark 
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The Input bookmark shows location of the source file that will be sent to a remote tool. 
This parameter was entered in the Parameters bookmark. 

 
 

 
 

Figure 5.22: Input bookmark 
 

 
The Output bookmark allows the user to specify a destination directory on the client side 
where the result of operation will be saved. Define default path and click on the Edit 
button. A new window will be displayed on the screen. 

 

 
 

Figure 5.23: Output bookmark 
 

Enter required location and click on OK button. 
 

 
 

Figure 5.24: Destination directory window 
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Now, the user can launch the tool. Click on  button. The user’s request will be 
sent to the Tool Server. Tool invocation parameters, may be saved with the use of the 

 button. In a new window the user can enter the localisation where parameters 
will be saved as an XML file. The saved file is described as a task and it includes 
complete list of parameters essential for the correct tool invocation. Later, the user can 
reuse the saved file for the same tool, as often as he wishes. 
 
 
 
6 TOOL/TASK – HOW TO ? 

6.1 Add a new tool 

In the first place each tool jointly used in the TRMS, has to be registered in the Global 
Tool Lookup Service's database. After opening the Tool/Task Menu the Register item 
should be chosen. Below, a proper dialog window is shown.  
 

 
 

Figure 6.1: Choose window 
 
Choose the Tool and click on the  button. 

 

 
 

Figure 6.2: Main info bookmark 
 
 
All fields should be filled in following the labels. The tool location in the file system could 
be chosen by means of the FileChooser window. The Tool Server that serves registering 
tool can be selected only from the Tool Servers currently registered in the GTLS’s 
database. In this purpose click on the Choose button and check the available Tool 
Servers. Additionally, the dialog window includes fields with version of tool's XML 
description and date of its creation. At the bottom of the dialog window the command line 
that will be used for launching the tool is displayed in the red colour. 
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The Description bookmark allows the user to add a short description of the registered 
tool.  

 

 
Figure 6.3: Description bookmark 

 
 

The tool can be launched with many characteristic parameters. The bookmark 
Parameters provide a possibility to declare them. It enables the user to specify the name 
of a parameter, a position in the command line, a type of the parameter, default value and 
its description. The user can also declare whether the parameter is required or can be 
changed while it is being invoked. Parameters only defined in this bookmark will be 
available for other users. This way, access to the tool can be limited to the registered 
user. Click on the Add button in order to add a new parameter. A new dialog window will 
be opened.  

 

 
 

Figure 6.4: Parameters bookmark 
 
Fill out all fields in accordance with labels. The Position field defines on which position in 
the command line the parameter will be added during tool invocation. The Type field 
defines a type of added parameter and must be chosen from the existing list. If parameter 
must be added to each invocation mark Required. If parameter can not be changed 
during tool invocation mark Not change. 
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Figure 6.5: Add a parameter window 
 
 
 

 
Figure 6.6: Type of a parameter list 

 
The user finishes editing parameter clicking on OK button. After edition a proper number 
of parameters user saves them in GTLS' database clicking on  button. This 
way, a new tool registration has been ended. 

 

 
 

Figure 6.7: Parameters bookmark 
 

6.2 Modify a tool 

This mechanism allows the user to modify tools' characteristics registered in the TRMS 
database. Open the Tools menu and select the Modify item. After activation of this item 
a proper dialog window appears. Tool name and also Keywords can be entered as the 
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attributes of the searched Tool. Next press the  button. The result of 
searching is displayed in the table form. If the user enters no attributes, all tools currently 
registered in the TRMS' database will be displayed.  

 
 

 
 

Figure 6.8: Search window 
 
The result of searching is displayed as a table. The Name column shows tool's name as it 
was registered in the TRMS. The Info column contains short tool description. The 
Keywords column includes words which are characteristic for this tool. The Name TS 
column gives the user information of the tool location and Available TS indicates that the 
Tool Server is currently available. Tool name as well as keywords could be used for 
searching the tools registered in TRMS.  

 

 
 

Figure 6.9: Search result 
 

Mark the selected tool and click on the  button. A new window with additional 
bookmarks appears. All fields are available for editing. In a similar way, as in the case of 
new tool registration, one can change attributes of a tool. 
 
6.3 Remove a tool 

This mechanism allows removal of tools registered in the TRMS database. Open the 
Tools menu and select the Remove item. After activation of this item a proper dialog 
window is displayed. Tool name and also Keywords can be entered as the attributes of 
the searched Tool. Next, press the  button. The result of searching is 
displayed in the table form. If the user enters no attributes, all tools currently registered in 
the TRMS' database will be displayed. 
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Figure 6.10: Search window 
 
The Name column shows tool's name, as it was registered in the TRMS. The Info column 
contains a short tool description. The Keywords column includes words which are 
attributes for this tool. The Name TS column gives the user information of the tool 
location and Available TS indicates that Tool Server is currently available. Tool name as 
well as keywords could be used for searching for tools registered in TRMS. 

 

 
 

Figure 6.11: Search result 
 

Mark a chosen tool and click on the  button. You will be asked for confirmation 
of operation. Click  Yes button. 

 
 

 
 

Figure 6.12: Confirmation window 
 
The chosen tool has been deleted from the GTLS database. System will display a 
suitable message.  

 

 
 

Figure 6.13: Info box 
 
 
 

6.4 Browse registered tools 

This mechanism allows a user to lookup for tools currently registered in the TRMS. Open 

the Tools menu and select the  item. After activation of this item a proper 
dialog window is displayed. Tool name and also Keywords can be entered as the 
attributes of the searched Tool. Next, press the  button. The result of search is 
displayed in the table form. If a user enters no attributes, all tools currently registered in 
TRMS' database will be displayed.  
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Figure 6.14: Search window 
 
The Name column shows tool's name as it was registered in the TRMS. The Info column 
contains a short tool description. The Keywords column includes words which are 
characteristic for this tool. The Name TS column gives the user information on the tool 
location and Available TS indicates that Tool Server is currently available. Tool name as 
well as keywords could be used for searching the tools registered in TRMS. 

 
 

 
 

Figure 6.15: Search result 
 

 
If one wants to browse detailed information on the tool, that was found, one has to mark 

the right user and click on the  button. A new window pops up. More 
information on the contents of this window one can find in section How to add a new 
tool? 
 
 
7 TOOL SERVER – HOW TO…? 

7.1 Add a new Tool Server 

Each Tool Server jointly exploited in the TRMS has to be registered in the Global Tool 
Lookup Service's database. After opening Tool Servers menu, the Add item should be 
chosen. Below, a proper dialog window is showed.  

 

 
 

Figure 7.1: Tool Server menu 
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All fields should be filled in following the labels. The Tool Server Name is a registered 
name of the Tool Server in the database. The Type communication field allows an 
administrator to choose a type of communication used by the specific Tool Server. 
Tomcat communication or ANTS communication types are available. The IP field 
determines IP and the port number utilised by Tool Server. The Expired field comprises 
expiry date. The Read Public Key allows the user to take Tool Server's public key from a 
certificate file and record them into the GTLS database.  

 
 

 
 

Figure 7.2: Main info bookmark 
 

 
 

Figure 7.3: Type of communication list 
 
The ANTS bookmark enables the user to specify Node Id for the registered Tool Server. 
Node Id is indispensable when ANTS is chosen as the type of communication.  
 

 
 

Figure 7.4: ANTS bookmark 
 
Groups bookmark allows the user to define who can access to the registered tool server.  
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Figure 7.5: Groups bookmark 
 

Click on the  button. A new window appears. The user can enter the name of 
the required group. If the user provides no group name, all groups currently registered in 
the TRMS' database will be displayed. 

 
 

 
 

Figure 7.6: Search window 
 

Mark the required group or role and click on the  button. A new item in the Group 
bookmark will be added. 

 
 

 
 

Figure 7.7: Search result 
 
The user can repeat this action several times for adding all required groups and roles. 
Next, click on TS Permission Level for each group and role, and select an adequate 
level.  
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Figure 7.8: Permission list 
 

If you want to browse detailed information of the granted privileges you mark appropriate 
group or role and click on the  button. A new window with two additional 
bookmarks appears. 
 

 
Figure 7.9: Permission bookmark 

 

7.2 Modify a Tool Server 

This mechanism allows the user to modify the attributes of the Tool Servers which are 
registered in the TRMS database. Open the Tool Server menu and select the Modify 
item. After activation of this item a proper dialog window will be displayed. Tool Server 
Name and also Tool Server IP can be entered as the attributes of the modified Tool 
Server. Next, press the  button. The result of searching is displayed as a table. 
If the user enters no attributes, all Tool Servers currently registered in TRMS' database 
will be displayed.  

 

 
 

Figure 7.10: Search window 
 

The result of searching is displayed in the table form. The Name column shows Tool 
Server's name as it was registered in the TRMS. The Description column contains a 
short description. The Valid until column includes the expiration date for this Tool Server. 
The IP column gives the user information of Tool Server location in the network and 
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Available indicates that Tool Server is currently available. Tool Server Name, as well as 
Tool Server IP could be used for searching the tool servers registered in TRMS. 
 

 

 
 

Figure 7.11: Search result 
 
Mark the chosen Tool Server and click on the  button. A new window with 
additional bookmarks pops up. All fields are available for editing. In a similar way one can 
change other attributes of the Tool Server.   

 

 
 

Figure 7.12: Main info bookmark 
 

7.3 Remove a Tool Server 

This mechanism allows the user to remove the Tool Server registered in the TRMS 
database. Open the Tool Server menu and select the Remove item. After item activation 
a proper dialog window will be displayed. Tool Server Name and also Tool Server IP can 
be entered as the attributes of the removed Tool Server. Next, press the 
button. The result of searching is displayed in the table form. If the user enters no 
attributes, all Tool Servers currently registered in the TRMS' database will be displayed.  



 
 
TRMS User’s Manual                            Vers. 2004-11-18 35

 

 

Figure 7.13: Search widow 

The search result is displayed as a table. The Name column shows Tool Server's the 
name as was registered in the TRMS. The Description column contains a short 
description. The Valid until column includes the expiration date for this Tool Server. The 
IP column gives the user information of the Tool Server location in the network and 
Available indicates that the Tool Server is currently available. 

 

 

Figure 7.14: Search result 

Mark the chosen tool server and click on the  button. You will be asked for the 
confirmation of operation. Click on Yes button. 

 

 

Figure 7.15: Confirmation box 
 

The chosen tool server has been deleted from the GTLS database. System will display a 
suitable message.  

 

 

Figure 7.16: Info box. 
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7.4 Browse registered Tool Servers 

This mechanism allows the user to browse Tool Servers registered in the TRMS 

database. Open the Tool Server menu and select the item. After activation of 
this item a proper dialog window will be displayed. Tool Server Name and also Tool 
Server IP can be entered as the attributes of searched Tool Server. Next, press the 

button. The result of searching is displayed in the table form. If the user enters 
no attributes, all Tool Servers currently registered in the TRMS' database will be 
displayed.  

 
 

 
 

Figure 7.17: Search window. 
 

 
The search result is displayed as a table. The Name column shows the Tool Server's 
name as it was registered in the TRMS. The Description column contains a short 
description. The Valid until column indicates the expiration date for this Tool Server. The 
IP column gives the user information of the Tool Server location in the network and 
Available indicates that the Tool Server is currently available. 

 
 

 
 

Figure 7.18: Search result 
 
If one wants to browse detailed information of the found tool server, one marks the 
appropriate one and clicks on the  button. A new window appears. More 
information about the contents of this window is available in section How to add a new 
Tool Server? 
 

8 USERS – HOW TO …? 

8.1 Browsing registered users 

This mechanism allows the user to lookup for other users who are currently registered in 

the TRMS. Open the Users Submenu and select the  Show item. After 
activation of this item a proper dialog window will be displayed. Login, name and also 
surname can be entered as the attributes of the user searched for. Next, press the 

 button. The search result is displayed in the table form. If the user enters no 
attributes, all users currently registered in the TRMS' database will be displayed.  
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Figure 8.1: Search window 

The Login column shows user's login as it was registered in the TRMS. The Name 
column contains user's name. The Surname column shows his surname. These three 
elements could be used for searching users registered in TRMS.  

 

Figure 8.2: Search result 
 

If one wants to browse detailed information on the found user then the appropriate one 

needs to be marked. Click on the  button. A new window with three additional 
bookmarks is available. The Main Info bookmark includes basic information on the 
registered user. All displayed information can be read but not modified. 

 
 

Figure 8.3: Main info bookmark 

The Groups bookmark shows an extent of granted permissions. The table consists of two 
columns. The first one contains name of the granted privileges. The second one contains 
description of the granted permissions. 



 
 
TRMS User’s Manual                            Vers. 2004-11-18 38

 
 

Figure 8.4: Groups bookmark 

The Institution bookmark shows to which institution the registered user belongs. 

 
Figure 8.5: Institution bookmark 

8.2 Add a new user 

At the beginning each user, who wants to use TRMS, has to be registered in the Global 
Tool Lookup Service's database. After opening the Users submenu, the Add item should 
be chosen. Below, the proper dialog window is shown. All fields should be filled in in 
accordance with labels. The User's Public key is read from a certificate file. Click on the 

 button. The File Selection window will be displayed. Enter the 
location of the file comprising the user certificate. The public key will be loaded. Fields 
with the expiration date and info will be filled in automatically by the system.  
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Figure 8.6: Main info bookmark 
 

The Groups bookmark is used to specify user permissions. The table consists of two 
columns. First column contains a name of a group, while the second one contains a 
description of a granted permission. Click on the Add button and the Group search 
criteria window will be opened. You can enter the searched name or the description. If 
the user enters nothing, all accessible groups will be displayed. 

 
 

 
 

Figure 8.7: Search group window 
 
 
Mark the searched group and press the button. The chosen group will be 

added. You can repeat this action several times. Finally, click on the  button 
that closes the window. 
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Figure 8.8: Search result 
 

This way, one can define permissions that will be possessed by the added user. If you 
want to delete some registration, you mark it and click on the  button. The 

 button enables viewing of marked permissions in the new window. The last 
task constitutes writing of data into the  GTLS database. Click on the  button. 

 
 

 
 

Figure 8.9: Groups bookmark 
 

The Institution bookmark allows the user to assign the institution name where he is 
employed. We proceed just as in case of user permissions. One can enter the searched 
name or the description. If the user enters nothing as a Name or Description all 
accessible institutions will be displayed. 
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Figure 8.10: Search institution window. 
 

Mark the proper institution and click on the  button. You can choose one only. 
The last task is writing data into the GTLS database. Click on the  button. This 
way, you have completed registration of the new user in TRMS. 

 
 

 
 

Figure 8.11: Search result. 
 

8.3 Modify user 

 
This mechanism allows the user to modify users' attributes registered in the TRMS 
database. Open the Users menu and select the Modify item. After activation of this item 
a proper dialog window will be displayed. Login, name and also surname can be entered 
as the attributes of the modified user. Next, click the  button. The result of 
searching is displayed as a table. If the user enters no attributes, all users currently 
registered in the TRMS' database will be displayed.  

 
 

 
 

Figure 8.12: Search window. 
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The result of searching is displayed in the table form. The Login column shows user's 
login, as it was registered in the TRMS. The Name column contains user's name. The 
Surname column shows his surname. These three elements could be used for searching 
the users registered in TRMS. 

 
 

 
 

Figure 8.13: Search result 
 

Mark user and click on the  button. A new window with three additional 
bookmarks is available. All fields are available for editing. In a similar way to a new user 
registration, one can modify user’s attributes.  

 

 
 

Figure 8.15: Main info bookmark 
 

8.4 Remove a user 

This mechanism allows a user to remove users registered in the TRMS database. Open 
the Users menu and select the Remove item. After activation of this item a proper dialog 
window will be displayed. Login, name and also surname can be entered as the attributes 
of the removed user. Next, press the  button. The result of searching is 
displayed as a table. If the user enters no attributes, all users currently registered in the 
TRMS' database will be displayed.  

 
 

Figure 8.15: Search window 
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The Login column shows user's login as it was registered in the TRMS. The Name 
column contains user's name. The Surname column shows his surname. These three 
elements could be used for searching the users registered in TRMS. 

 
 

Figure 8.16: Search result 
 

Mark the user and click on the  button. You will be asked for confirmation of 
the operation. Click on the Yes button. 

 
 

Figure 8.17: Confirmation box 

The chosen user has been deleted from the GTLS database. System displays the 
suitable message.  

 

 

Figure 8.18: Info box 
 

9 OPTIONS 
 
The Options Menu includes four items. 
 

 
 

Figure 9.1: Options menu 
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The User configuration item enables a suitable configuration of a client application 
through the setup of proper parameters determining cooperation with the GTLS and Tool 
Servers. Three bookmarks are available. The Global bookmark allows the user to specify 
a type of communication with the GTLS server. Tomcat and ANTS communication are 
possible. Frequency of ping to GTLS field determines in seconds how often pings to 
GTLS are sent. Encryption thick switches on and switches off encryption methods for 
communication protection. Affirmation of a secure data transport in TRMS is realized 
through the utilisation of cryptographic methods and the digital signature technology. 
Design data are encrypted during transportation. Encryption with the public key method, 
as well as encryption with the symmetric key method is used simultaneously. 
Compression thick switches on and switches off compression methods. Compression of 
data before their dispatch to a receiver allows limitation of network traffic and significant 
decrease of data transmission time. Proxy server thick enables cooperation between 
TRMS and the Proxy Server. 
 
 

 
 

Figure 9.2: Global bookmark 
 

 
The Client bookmark enables the user to choose a type of the used Client GUI. GUI for 
end-user, Tool Server administrator GUI, as well as the GTLS administrator GUI are 
available. Remaining fields store information on the location of files with user and GTLS' 
keys, user's working directory, as well as the IP number of the GTLS server. 
 

 
 

Figure 9.3: Client bookmark 
 

 
The TS bookmark enables the user to specify essential parameters for the Tool Server 
administrated by him. 
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Figure 9.4: TS bookmark 
 

The User profile item displays complete information of the logged user. All data could be 
browsed and modified. More details about modification of user’s parameters one can find 
in section Users – How to …? 

 

Figure 9.5: Main info bookmark 

The Look & Feel item allows user to change appearance of the client application. Metal, 
Windows as well as Motif colour schemes are possible. 
The Close all Windows item closes all opened windows. 

 

10 ADMINISTRATION 
 
The Administration menu allows a suitable configuration of GTLS, as well as 
supervision of users’ behaviour and system operations. It includes four items. 
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Figure 10.1: Administration menu 

The GTLS configuration item is used for configuration of GTLS and its Databases. 
There are two bookmarks. The Database bookmark allows the user to setup essential 
parameters for getting a correct service of databases. Two databases are utilized by 
TRMS. In the first one, information on registered users, and in the second one the 
registered tools are stored. All fields should be filled out in accordance with labels. 

 

Figure 10.2: Database bookmark 

The Setting GTLS bookmark enables the user to enter suitable parameters for correct 
cooperation between the client application and the GTLS Server. 
Encryption thick switches on and off encryption methods for communication protection. 
A secure data transport in TRMS is realized through utilization of cryptographic methods 
and the digital signature technology. Design data are encrypted during the transport. 
Encryption with the public key method and the one with the symmetric key method are 
used simultaneously. 
Compression thick switches on and off compression methods. Compression of data 
before their dispatch to receiver allows limitation of the network traffic and decreases 
significantly the time of data transmission. 
Proxy server thick enables cooperation between TRMS and the Proxy Server. 
Information included in the Base frame preliminary configures GTLS. They point at 
location of the file with GTLS' keys pair and the working folder. 
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Figure 10.3: Setting GTLS bookmark 

 
 
11    PERMISSIONS 

11.1 User permissions 

 
The range of user permissions in the TRMS environment is related to the membership of 
a given group. A number of groups is optional. Each user who possesses adequate 
permissions can create a new group. 
 
 

 
 

Figure 11.1: Groups bookmark 
 
The system of privileges for a specific group is divided into five levels (none, watch, 
invoke, edit, administrator) and is related with operations performed on eight objects 
(Tool, User, Group, Institution, TS, Manage GTLS, Task, Workflow). For each object the 
user can choose one of five levels.  Upper level includes lower level permissions. 
 
 



 
 
TRMS User’s Manual                            Vers. 2004-11-18 48

 
 

Figure 11.2: Permission bookmark 
 
 

11.2 Tool Server Permissions 

The granted permissions of a given group control access to Tool Server resources.  The 
user receives the adequate permissions in the moment of accession to the group. The TS 
administrator makes an additional control of the specific group permissions for accessing 
to a given Tool Server. The TS administrator can limit or grant additional permissions to 
the concrete group to perform operation in the moment of Tool Server registration. 
 

 
 

Figure 11.3: Group list 
 

 
 
 
 
12  FURTER DEVELOPMENT OF TRMS  
            
R & D on TRMS is being continued. The progress is monitored on TRMS web pages, i.e. 
on www.ecolleg.org/trms  
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Appendix A  How to generate user’s keys? 
 
The keystore file with user’s public and private keys can be generated in two ways. 
Directly, with the keytool tool attached to each Java 2 SDK edition or with KeyTool GUI, 
the small program available under the GNU Public License on the Web. This text 
concerns the second case. Below, some screenshots and advises are given. 
 
1.  Open KeyTool GUI. 
 

 
 
2.  Open the File submenu in the main menu and choose the New KeyStore item. 
 

 
 
3.  Select JCEKS as the type of the new KeyStore and click on the OK button. 
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4. Open the Tools submenu and choose Generate Key Pair item. 
 

 
 
 
5.  Select RSA as the key algorithm and enter key size 1024 bits, then click on the OK 
button. 
 

 
 
 
6. Select MD5 with RSA as the signature algorithm and fill in all fields in accordance with 
labels.  
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7.  VERY IMPORTANT:  TRMS requires “user” as an alias name.  
 

 
 
 
8.  Enter password and confirm. The keystore file uses two passwords. First password 
protects access to the keystore file. Another password protects access to the user private 
key. If one wants to get a certificate from keystore only, the first key is needed. But if one 
wants to get the private key, one must know both passwords. The passwords can be 
different or the same. In the TRMS both passwords are the same. This simplifies logging. 

 

 
 
 
9.  Keys are generated. 
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10. Now, one has to create a certificate with one’s public key. The certificate will be sent 
to the TRMS’ administrator. Mark “user” entry and right-click on. Then select the Export 
item. 

 

 
 

 
11. Select Head Certificate and DER Encoded. 
 
 

 
 
12.  Define where the certificate file has to be stored. 
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13. Save your keystore. 
 

 
 
 
 
14.  Enter password and confirm. IMPORTANT look at point 8. 
 

 
 
 
 
15. Define, where the keystore file has to be stored. 
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16. Creation of the keystore file is ended. Send your certificate file to the TRMS 
administrator. 
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APPENDIX  B   TRMS support  
 
 
 
 
 
 
 
 
 

 

 

At www.ecolleg .org the following demonstrations are available: 

TRMS demonstrations  
1. TRMS concept [ www.ecolleg.org/DISSEMINATION/Demos/trms_idea.html ] 

- demonstrates basic concepts in TRMS.  

2. A Client to the TRMS environment 
[www.ecolleg.org/DISSEMINATION/Demos/trms_intro.html ] - a short 
description of the graphical interface.  

3. SUT / Infineon Technologies application scenario 
[www.ecolleg.org/DISSEMINATION/Demos/scenario_sut_ifx.html ].  

4. Encryption [www.ecolleg.org/DISSEMINATION/Demos/encryption.html] - 
security issues in TRMS.  

 
 
 

 
Support is available to all registered TRMS users through the web pages: 
 

www.ecolleg.org/trms 
 
and on e-mail:  

trms-support@ciel.pl 


